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Here are answers to frequently asked questions NHRS employers may have concerning recently enacted legislation.

On June 29, 2011, House Bill 2 (HB 2) became law (Chapter 0224, Laws of 2011). Some of the retirement system-related 
sections of HB 2 took effect upon passage, some sections take effect July 1, 2011, and other sections take effect Jan. 
1, 2012.

NHRS sent out an offi cial employer notifi cation on the passage of HB 2 on June 29, 2011. The notice is available here:  
http://www.nhrs.org/documents/NHRS_Employer_Notifi cation_HB2_06_29_11.pdf

Additional employer information will be provided. (As it is developed.)

HB 2 increases member contribution rates effective July 1, 2011. When should employers begin using the 
new rate?

Employers must use the new rate on any payroll paid to the employee on or after the effective date. For example: 
If the  pay period 6/17-6/30/2011 will be paid on 7/1/2011, NHRS will expect 7 percent contributions on Group I 
member wages in this payroll.

The new employee rates are:
Group I Employee and Teacher: 7 percent.
Group II Police: 11.55 percent.
Group II Fire: 11.8 percent.

What are the contribution rates employers should begin paying July 1, 2011?

The fi scal 2012-13 rates adopted by the NHRS Board of Trustees last fall take effect July 1, 2011.

Political subdivision employer rates are available here:
http://www.nhrs.org/documents/2012_2013_contribution_rates_municipal.pdf

State employer rates are available here:
http://www.nhrs.org/documents/2012_2013_contribution_rates_state_FINAL.pdf

The State of New Hampshire has traditionally contributed a portion of municipal employer contributions for 
Teacher, Police, and Fire members. How does that change as result of HB 2?

HB 2 eliminates the state’s cost sharing and requires employers to pay 100% of the employer contribution rate.

However, HB 2 also authorizes the state to spend $3.5 million in Fiscal Year 2012 toward political subdivision employer 
contributions for Group I Teachers and Group II Police and Fire members; NHRS is still determining how this 
appropriation will be disbursed. By way of comparison, $46.8 million was budgeted by the state in FY 2011 for this 
purpose.

For all compensation paid on or after July 1, 2011, local employers must pay the full contribution rates determined 
by the actuary and approved by the Board of Trustees. If an employer withholds payment, they will be billed for the 
remaining balance.
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Are the employer rates taking effect July 1, 2011, expected to change at a later date?

Section 188 of HB 2 directs NHRS trustees to recertify employer rates “as soon as possible after July 1, 2011.”

However, on June 28, 2011, the NHRS Board of Trustees voted, 7-5, to seek a court injunction regarding the 
employer rate certifi cation contained in Section 188 of HB 2. The vote refl ected the majority’s concern that Section 188 
usurps the board’s authority under Part I, Article 36-a of the New Hampshire Constitution.

The court did not grant NHRS’ request for an injunction; the case is scheduled to be heard in October.

Regardless of the legal action, the rate recertifcation process was expected to take between one and three months. 
The retirement system’s consulting actuary is currently developing draft employer rates based on the recertifi cation 
language contained in HB2.

More information on the board’s action is available here:
http://www.nhrs.org/News/Files/06_29_11_NHRS_Board_Action_on_HB2.pdf

The Board of Trustees’ action does not affect the timing of the implementation of the other retirement system 
provisions in HB 2. However, a coalition of public employee groups fi led a separate, unrelated motion regarding the 
implementation of new member rates and new employer rates. The court is scheduled to hear this case in August. In 
the meantime, employers should continue to use the member and employer rates cited above.

If new employer rates are certifi ed within a few months, will there be any adjustment for previous payments 
made at the current rate?

The rate recertifi cation language in HB 2 is not retroactive.

Can I hire retirees collecting a pension from NHRS for part-time employment?

HB 2 defi nes “part-time” for NHRS retirees in receipt of a pension as no more than 32 hours per week, with an 
exception for employment within a fi ve-consecutive month block of any 12-month period. For all other part-time em-
ployees, the current administrative rules governing part-time employment remain in effect, provided they do not con-
fl ict with any legislation enacted into law.

What is the status of the so-called “spiking” legislation?

House Bill 462 (HB 462) has been passed by the Legislature and signed by the Governor. HB 462 delays the effective 
date of any “spiking” assessment until July 1, 2012. 

As a courtesy to its participating employers, NHRS will be providing each employer with a copy of the 2011 NHRS 
statutory provisions book (“law book”). Employers are encouraged to retain a copy of the law book as a reference. 
Town administrators, fi nance directors, and personnel managers often fi nd the law book to be a helpful reference. 
The law books are not expected back from the printer until later in the year.

NHRS is governed by statute (NH RSA 100-A) and administrative rules. Both the statute and rules may be 
accessed from the NHRS website at: http://www.nhrs.org/PlanAdministration/Details.aspx.

NHRS Law Book

Continued from page 1

The New Hampshire Retirement System (NHRS) is governed by New Hampshire RSA 100-A, rules, regulations, and Federal laws including the Internal Revenue Code.  NHRS also 
implements policies adopted by the Board of Trustees.  These laws, rules, regulations, and policies are subject to change.  Even though the goal of NHRS is to provide information 
that is current, correct, and complete, NHRS does not make any representation or warranty as to the current applicability, accuracy, or completeness of any information provided.  The 
information herein is intended to provide general information only, and should not be construed as a legal opinion or as legal advice.  Members are encouraged to address specifi c 
questions regarding NHRS with an NHRS representative.  In the event of any confl ict between the information herein and the laws, rules, and regulations which govern NHRS, the laws, 
rules, and regulations shall prevail. 
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NHRS Frequently Asked Questions Concerning 

New Law Governing Part-Time Employment of Retirees

Here are answers to some frequently asked questions 
NHRS employers and retirees may have concerning 
recently enacted legislation regarding the part-time 
employment of retirees by an NHRS participating 
employer. 

What does the new law say?

Section 178 of House Bill 2, enacted into law on June 
29, 2011, reads:

Retirement System; Part Time; Group I and Group 
II.  Amend RSA 100-A:1 by inserting after paragraph 
XXXIII the following new paragraph:
 XXXIV.  “Part-time,” for purposes of employment 
of a retired member of the New Hampshire retirement 
system, but excepting per diem court security offi cers 
and court bailiffs, means employment by an employer 
depending on the group classifi cation of the employment 
as follows:
  (a)  For group I, part-time employment 
of the retired member shall not exceed 32 hours in a 
normal calendar week; except for group I employment 
which in some instances may exceed 32 hours in any 
normal calendar week.  In such case the part-time 
employment of the retired member shall not exceed 
1,300 hours in a calendar year, so long as such part-time 
employment does not occur outside of a 5-consecutive-
month period in any 12-month period.
  (b)  For group II, part-time employment 
of the retired member shall not exceed 32 hours in a 
normal calendar week; except for group II employment 
which in some instances may exceed 32 hours in any 
normal calendar week.  In such case the part-time 
employment of the retired member shall not exceed 
1,300 hours in a calendar year, so long as such 
part-time employment does not occur outside of a 
5-consecutive-month period in any 12-month period.
 
When does this law take effect?

July 1, 2011.

Who does it affect?

Anyone who retired from an NHRS participating employer 
and is currently receiving a pension benefi t. 

Part-time employees who are not receiving a pension 
benefi t from NHRS are not affected by the change and 
remain subject to the Minimum Participation Standards 
contained in the NHRS Administrative Rules (302.5).

Does the law prevent NHRS retirees from working 
more than 32 hours per week for a non-NHRS 
employer?

No. The 32-hour limit only applies to retirees working 
part-time for an NHRS participating employer. There 
is no limit on how much an NHRS retiree can work for 
an employer that does not participate in the retirement 
system.

If a retiree works part-time for multiple NHRS 
participating employers, is the retiree limited to a 
total of 32 hours per week?

No, the 32-hour limit is per employer. Note: Multiple 
school districts in the same School Administrative Unit 
(SAU) are considered a single employer.

If a retiree works part-time in a Group I position 
and part-time in a Group II position for the same 
employer, are those hours counted together?

No. Per the statute, hours worked in a Group I 
(Employee and Teacher) position and hours worked in a 
Group II (Police and Fire) position are counted separately.

I am receiving a pension from NHRS and working 
more than 32 hours for an employer that did not 
have its Employee members participate in the 
retirement system at the time I commenced 
employment. My employer subsequently joined 
NHRS, but I exercised my option to not participate 
in the retirement system pursuant to RSA 100-A:22 
(Modifi cations). Do I need to reduce my hours?

No. Employees in this situation are not subject to the 

32-hour limit.

NHRS offers retirement education sessions to teachers, 
employees, fi refi ghters, and police offi cers throughout the 
state who are NHRS members, not yet retired. During 
these general information programs, members of all ages 
and in various stages of their career are provided with 
information about NHRS benefi ts, including an overview 
of NHRS as a defi ned benefi t plan; service, early, 
disability, and vested deferred retirement; pre-retirement 
and post-retirement death benefi ts; and other important 

Retirement System Member Education Sessions

aspects of NHRS retirement benefi ts. Please note that 
personalized account information, pension estimates, and 
information about retiree health insurance are not offered 
during these sessions.

If you would like to host one of these sessions for your 
employees please contact the Public Information Offi ce at:
public_relations@nhrs.org



Reminders from NHRS Employer Services

► The enrollment date for any teacher who occupies 
an NHRS-covered position is always the first day the 
teacher begins working full-time.  This can sometimes 
cause confusion for school district employers because 
a teacher’s NHRS enrollment date may not be the 
same as his/her contract commencement date. 

For example, if an employer enters a teacher’s 
contract commencement date of September 1st as the 
enrollment date, but the teacher actually started working 
and began to be paid as of August 25th, an exception 
(error) will occur when the employer submits the wage 
and contribution information to the NHRS Employer 
Reporting System (ERS).  This is because the wages 
were paid before the enrollment date.

Employers must record the enrollment date for teachers 
as the first day actually worked for which they will 
receive pay, regardless of the effective date of the 
contract.

► The ERS will not download a file that contains a 
double file extension, for example, “1145.xml.xml”.  
This issue is caused by a setting within Windows 
called “Hide extensions for known file types” (Windows 
Explorer\Folder Options\View).

When this feature is checked, it hides from view the 
extension of all known file types, which include “.XML”.  
Since the user is unable to see the extension, he or 
she may inadvertently add it, resulting in a file with a 
double extension.  

To display the file extension, open Windows Explorer 
(not Internet Explorer), choose Folder Options from 
under the Tools menu, click on the View tab, uncheck 
“Hide extensions for known file types,” and hit OK.

This setting may also be accessed through the 
Control Panel. Open the Control Panel, click on Folder 
Options, click on the View tab, uncheck “Hide extensions 
for known file types,” and hit OK.

► Salary continuance payments for which both the 
employee and employer contributions are remitted 
electronically through the employer’s monthly file do 
not require the completion of a salary continuance form.  

However, if an employee who has terminated employment 
continues to receive employer-sponsored long-term 
disability/short-term disability (LTD/STD), the employer 

must continue to report/remit for that employee and 
submit a salary continuance form. It may be necessary 
for the employer to contact the insurance carrier to 
determine how much the member receives in order to 
complete the salary continuance form. 

Visit the Employer Resources section of the NHRS 
website to locate the salary continuance form on the 
Forms page. http://www.nhrs.org/Employers/Forms.aspx

If assistance is needed, employers may contact an 
Employer Services representative.

► NHRS is aware that some employers continue 
to report “payments in lieu of health insurance.”  As 
of August 29, 2008, this payment type is not report-
able to NHRS pursuant to the definition of Earnable 
Compensation.  Employers are requested to notify an  
Employer Services representative if they have inadver-
tently reported these payments since that date.

► NHRS now offers an Electronic Funds Transfer 
option for the retirement system’s payment of post-re-
tirement medical premiums to employers or third-party 
administrators.  Visit the Employer Resources section 
of the NHRS website to locate the application on the 
Forms page. http://www.nhrs.org/Employers/Forms.aspx

► Employers are encouraged to review NHRS 
post-retirement medical payments, the corresponding 
Insurance Deduction Register and any additional backup 
materials to ensure the accuracy of the payment.  It 
is important that any discrepancies be immediately 
reported to an Employer Services Insurance represen-
tative.  NHRS reserves the right to recover any overpaid 
Medical Subsidy benefits.

► Pursuant to RSA 100-A:50, employers are reminded 
that retiring political subdivision employees must be 
permitted, upon retirement, to continue to participate 
in the same medical insurance or health care group 
or plan as active employees and that retired employees 
must be deemed to be part of the same group as 
active employees for purposes of determining medical 
insurance premiums.

Employers using a third-party administrator such as 
LGC, Schoolcare, or Primex are advised to ensure 
compliance with the above referenced statute.

To receive important NHRS related information, please visit the 

NHRS website at www.nhrs.org to sign up for Email Updates. 

NHRS Email Updates
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